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Preface

Profile
Before You Begin This Course
Before you begin this course, you should have the following qualifications:
e Thorough knowledge and proficiency in navigating Oracle applications

e  Working experience with a working knowledge of the manufacturing
business process

Prerequisites

e  Oracle Inventory

e  Oracle Bills of Material and Oracle Engineering
How This Course Is Organized

R11i Managing Demand, Oracle Flow Manufacturing is an instructor-led course
featuring lecture and hands-on exercises. Online demonstrations and written
practice sessions reinforce the concepts and skills introduced.
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Related Publications

Oracle Publications

Title Part Number
Oracle Inventory User’s Guide A83507-01
Oracle Bills of Material User’s Guide A75087-01

Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide
A82941-01

Oracle Work in Process User’s Guide A83598-01
Oracle Flow Manufacturing User’s Guide A69396-01
Additional Publications

e System release bulletins

e Installation and user’s guides

e read.me files

e  Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention | Element Example

Bold italic Glossary term (if The algorithm inserts the new key.
there is a glossary)

Caps and Buttons, Click the Executable button.

lowercase check boxes, Select the Can’t Delete Card check box.
triggers, Assign a When-Validate-Item trigger to the
windows ORD block.

Open the Master Schedule window.

Courier new,
case sensitive

Code output,
directory names,

Code output: debug.set ('I”, 300);
Directory: bin (DOS), SFMHOME (UNIX)

(default is filenames, Filename: Locate the init . ora file.
lowercase) passwords, Password: User tiger as your password.
pa}t{linames, Pathname: Open c: \my docs\projects
U S ¢ URL: Goto http://www.oracle.com
uset put, User input: Enter 300
usernames
Username: Log on as scott
Initial cap Graphics labels Customer address (but Oracle Payables)

(unless the term is a
proper noun)

Italic Emphasized words | Do not save changes to the database.
and phrases, For further information, see Oracle7 Server
titles of books and | SOL Language Reference Manual.
courses, Enter user id@us.oracle.com,
variables where user id is the name of the user.
Quotation Interface elements Select “Include a reusable module component”
marks with long names and click Finish.
that have only
initial caps; This subject is covered in Unit II, Lesson 3,
lesson and chapter | “Working with Objects.”
titles in cross-
references
Uppercase SQL column Use the SELECT command to view
names, commands, | information stored in the LAST NAME
functions, schemas, | column of the EMP table.
table names
Convention | Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention | Element Example
Caps and Oracle Forms When-Validate-Item
lowercase triggers
Lowercase Column names, SELECT last name
table names FROM s_emp;
Passwords DROP USER scott
IDENTIFIED BY tiger;
PL/SQL objects OG_ACTIVATE_LAYER

( OG_GET LAYER
(‘prod pie layer’))

Lowercase Syntax variables CREATE ROLE role

italic

Uppercase SQL commands and | SELECT userid
functions FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve
This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.
3. (B) Click the Approve button.
Notations :

(N) = Navigator

(M) =Menu

(T) = Tab
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(I) = Icon
(H) = Hyperlink
(B) = Button
Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—
(Help) General Ledger > Journals > Enter Journals
—represents the following sequence of actions:

1. Inthe navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.
3.  Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help
Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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R11i Managing Demand ,
Oracle Flow Manufacturing

tion, 2000. All right
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Objectives

Objectives

After completing this lesson, you should be able to
do the following:

Understand the role of Demand Management in
Flow Manufacturing

Understand the use and function of Product
Families

Create and maintain Product Family forecasts

Understand how and when Product Family
forecasts are consumed

Understand the role of MDS/MPS in Flow
Manufacturing

Understand the purpose and functionality of
tolerance fences

Goal of Demand Management:
Define the anticipated market share percentage in terms of a product mix.

Once the product mix is defined, the products can be grouped into families
based on the communality of processes that they go through.

After families are created the production lines are designed to build all the items
in that family in a mix model basis.

Oracle Flow Manufacturing enables you to analyze demand, group products
into product families, and manage demand on a day by day basis.
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Demand Sources in Flow Manufacturing

Demand Sources in Flow Manufacturing

Forecast
Balance flow lines

Master Demand
Schedule (MDS)

Q35 -5 35S0 —T

Kanban planner

Master Production
Schedule (MPS)

Actual Production Line scheduling

SO0 =—=C O® X M

Demand Sources

Demand sources are used in Flow Manufacturing during both the design phase
and during manufacturing execution.

During the design phase they are used for:
* Defining the design capacity of the flow lines and establishing line TAKT.

* Sizing and stocking kanban containers to support the design and customer
demand.
During execution customer orders or planned orders are scheduled for
production on the flow line. Once scheduled, that demand can be used for:

* Comparing the mix and demand of the schedule to the balanced line to
determine bottlenecks and resource requirements.

*  Comparing the schedule to the production kanbans to determine if
component supplies are adequate.
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Partners in Demand Management

Partners in Demand Management

Marketing

Flow Flow

procli uction production
lines lines

- (=

Supplier Supplier

Demand Management
In Flow Manufacturing, the need to create a partnership between Sales and
Marketing, production and suppliers becomes essential to success. Strategy
must be developed to synchronize the flow of products from supplier to the flow
line, to the distribution network, and finally to the customer.

In determining the demand schedule, the following factors should be taken into
account:

Product volume

Factor pricing and promotions within the product volume
Supplier relationships developed to support product volume
Predicted growth patterns

New product introductions
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Demand Planning at Vision Computers

Demand Planning at Vision Computers

Sales and Marketing

Establish Product Volumes for a future date

Suppliers
Add Vision Computer forecast to production plan

Production
Balance line to volume, size kanbans, generate
planning forecast for suppliers

O

The Partnership at Vision Computers

Production volume was negotiated for the Laptop Product Family at a rate of
1,000 per manufacturing day. Each partner supported this agreement in the
following ways:

* Sales and Marketing:
— Marketing its laptop product line at the rate of 55,000 for the quarter
* Production:

— Balancing the flow line to 1,100 a day, with allowable flex
percentages

— Determining Kanban requirements

— Communicating component requirements to the suppliers via the
WEB

* Suppliers:

— Adding Vision Computer’s component forecast to their production
plan, thereby reserving capacity for their strategic partner.
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Types of Demand

Types of Demand

Customer

Forecast order Inter-org
orders

— -

Planning Tools

Types of Demand

Oracle Flow Manufacturing uses the Demand Management tools provided in
Oracle APS, MPS/MRP, or Supply Chain Planning to plan production.

Types of Demand include:

» Forecasts: By Product Family or Finished Goods
Note: Product Family forecasts cannot be generated from member
item shipments

» Customer orders

 Inter-org transfer orders

* Manual MDS entries

* Manual MPS entries
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Planning Product Families

Planning Product Families

Product
Family

» Forecast by product family

» Master demand schedule by product family

» Master production schedule by product family
* Rough cut capacity planning by product family

Copyright © Oracle C ation, 2000. All rights reserved

Planning for Product Families
In Flow Manufacturing where mixed model production is supported, planning at
the aggregate level of product family yields greater accuracy. To plan
production for a flow line by product family:

* Forecast by product family

* Schedule for product family

* Plan material for product family
Note: Typically, a Flow Line is designed for one specific product
family containing a mix of products. However, flow lines can be
designed for multiple product families.

Note: Product families are not required for flow manufacturing.
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Product Family Versus Planning Bills

Product Family Versus Planning Bills

Planning - Product
Bill ~ Family

- Member
ltem2

Copyright © Orac ion, 2000. All right:

Forecast Explosions
* Product families are like planning bills in the following ways:
* Both are nonbuildable items
* Both group items for forecasting purposes
* Both are used to enter forecasts
* Both explode their forecasts to their member items
How Product Families Differ from Planning Bills
* Product family forecast is consumed by member item sales orders.

* Planning bills add their components in the bill define window, product
family members are assigned in the assign members window.

* Planning bills distribute their forecasts based on planning percentage in
BOM, product families distribute their forecasts based on allocation
percentage.

* Product family member allocations can be phased in with effectivity dates,
and planning bill components planning percentage can change with ECO
implementation.
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Practice Setups

Practice Setups
nn-Famil

Assembly Assembly
nn-M1 nn-M2

Kanban Kanban Kanban Kanban
nn-KB2 nn-KB3 nn-KB2 nn-KB4
Kanban Kanban
nn-KB1 nn-KB1

tion, 2000. All right

Product Family Structure

To support the practice exercises, we need to set up a product family consisting
of two finished assemblies each with a corresponding bill of material.

Unless otherwise noted, all organization assignments are for M1 Seattle
Manufacturing.

Save your work at the end of each step.
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Practice Setups DM-1

Instructions:

Using the following information, perform the setup.
Replace nn with your initials.

Finished Goods Models and Bills of Material

1. Create two finished assembly products

2. Create four kanban component items

3. Create a Bill of Material for the finished assemblies

1. Create two finished assembly products
Product 1: nn-M1
(N) Flow Manufacturing > Products and Parts > Master Items
Description = Assembly 1
Template = Finished Goods
Organization Assignment = M1 Seattle Manufacturing
Product 2: nn-M2
Description = Assembly 2
Template = Finished Goods
Org-level Attribute Setting:
Planning Method = MRP Planning
Forecast Control = None
Release Time Fence = Kanban (Do Not Release)
2. Create four kanban component items
Kanban Items: nn-KB1 through nn-KB4
(N) Flow Manufacturing > Products and Parts > Master Items
Description = nn Kanban Item (1 through 4)
Template = Purchased Item
Org-level Attribute Setting:
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Practice Setups DM-1 (continued)

Instructions:

Using the following information, perform the setup.
Replace nn with your initials.

Finished Goods Models and Bills of Material

1. Create two finished assembly products

2. Create four kanban component items

3. Create a Bill of Material for the finished assemblies

2. Create four kanban component items (continued)
Planning Method = MRP
Forecast Control = None
Release Time Fence = Kanban (Do Not Release)
WIP Supply Method = Assembly Pull
WIP Supply Subinventory = RIP
3. Create a BOM for each of the products that you created in step 1.
Product 1 BOM
(N) Flow Manufacturing > Bills > Bills
Parent = nn-M1
Component = nn-KB1; qty = 1; backflush material subinventory = RIP
Component = nn-KB2; qty = 2; backflush material subinventory = RIP
Component = nn-KB3; qty = 1; backflush material subinventory = RIP
Product 2 BOM
Parent = nn-M2
Copy Bill from... nn-M1
Replace component nn-KB3 with nn-KB4; qty = 1
Set component nn-KB1 backflush material subinventory = Stores
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Practice Setups DM-2

Instructions:

Using the following information, perform the setup.
Replace nn with your initials.

Product Family

1. Create a Product Family

2. Create Product Family Members

1. Create a Product Family
(N) Flow Manufacturing > Products and Parts > Product Family
The product family template is applied.
Note: You are not required to use the product family template. If you choose
not to use a template, make sure that you define the correct product family
attributes. Specifically, the item must be an inventory item and the BOM
Item Type must be Product Family. The item must also be BOM allowed.
Product Family Name = nn-Family
Enter a description.
Organization Assignment = M1 Seattle Manufacturing
2. Create Product Family Members
Family Member, nn-M1
¢  Member Item = nn-M1
* Allocation Planning % = 60
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Practice Setups DM-2 (continued)

Instructions:

Using the following information, perform the setup.
Replace nn with your initials.

Product Family

1. Create a Product Family

2. Create Product Family Members

2. Create Product Family Members (continued)
Family Member, nn-M2
*  Member Item = nn-M2
* Allocation Planning % = 40
(N) Flow Manufacturing > Products and Parts > Product Family Members
Navigate to the Product Family window, and your select a product family item.

Select item members for the product family. The description, type, forecast
control, and planning method for the member items are displayed for the items
selected.

Note: When an item is included in a product family, it is automatically assigned
to the same category as the family item.

Commit the record by selecting Save from the File menu.

Note: You can commit a record without assigning planning percentages. The

default planning percentage is 100. The default effectivity date is the system
date.
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Forecasting

Forecasting

Forecast “Laptop Products”
product family

Copyright © Oracl ion, 2000. All rights

Forecasts
A forecast shows predicted future demand for items over time.
You can forecast at the aggregate level using product family forecasts. With
each forecast entry, you enter the days, weeks, or periods and the quantities that
you expect to ship. The product family forecast is then exploded to its
members.
You can load forecasts, together with sales orders, into master demand and
production schedules, and use the master schedules to drive line design, kanban
requirements and planned material requirements.
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Forecasting Product Families

Forecasting Product Families

Forecast sets MB-FCSet

e

Forecast Western Region
names

e

Forecast Product Family
items

——

Qty Due
Forecast mb-fam 10000 01-Oct-98

entities mb-fam 20000 01-Nov-98

Copyright © Oracl tion, 2000. All rights res

Forecasting for Product Family

Forecasts for product families are created like any other manual forecast. You
must:

* Create a forecast set.

* Create one or more forecast names.

* Add product family items to forecast names.
Note: You can add forecasts for any item, along with product family
forecasts.

» Add forecast entries for product families items.

Optionally, assign product family forecast entries to a specific flow line. If left
blank, then the system looks for a flow routing to determine the line.
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Forecast Set

Forecast Set

NATIONAL
Forecast Set

WESTERN CENTRAL EASTERN
Regional Regional Regional
Forecast Forecast Forecast

Source

Central
Eastern
Western

Forecast Sets

Forecast sets are used to group one or more forecasts. Each regional forecast

may contain specific forecasts for product families, family members, and spare
parts.

Before you define a forecast, you first define a set. Forecast sets:
* Group complementing forecasts that sum to a meaningful whole
* Group forecasts that represent different scenarios

You can associate a forecast to one forecast set only.

Some forecast set information—such as forecast level—defaults to the forecasts

you create within the set. You can keep or override these defaults for a specific
forecast.

Forecasts and Sets

Forecast sets consist of one or more forecasts. Sets group complementing
forecasts into a meaningful whole. For example, a forecast set could contain
separate forecasts by region.

Forecast Names

Each forecast inherits the forecast level, consumption options, and other

defaults defined for the set. You can override these defaults for each forecast
name in a set.
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Forecast Set (continued)

Forecast Set (continued)

NATIONAL
Forecast Set

WESTERN CENTRAL EASTERN
Regional Regional Regional
Forecast Forecast Forecast

Source

Central
Eastern
Western

Copyright © C tion, 2000. All rights res

Forecast Items

The items to be forecasted are added to each forecast name. In flow, this is
typically the product family product. You can also add forecasts for any other
item to cover such things as spare part inventories.

Forecast Entries

You can enter specific forecast information including dates and quantities. It is
in this form that the flow line may be specified.

Time Buckets

You can forecast with daily buckets in the short term, weekly buckets in the
midterm, and periodic buckets in the longer term.

Consumption

You can manually or automatically consume forecasted demand with sales
order (actual) demand. Consumption follows a forecast explosion and can be
done prior to, or during, the MPS plan generation.
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Forecast Set (continued)

Forecast Set (continued)

NATIONAL
Forecast Set

WESTERN CENTRAL

Regional Regional
Forecast Forecast

EASTERN
Regional
Forecast

Source

Central
Eastern
Western

tion, 2000. All right

Consume by Demand Class

You can define demand classes that represent groupings of similar customers or

order types. This allows you to consume forecasts by sales orders of a specific
demand class, for example.

Consume by Item, Customer, Bill-to Address, or Ship-to Address

You can consume forecasts at four different forecast levels: item, customer, bill-
to address, or ship-to address forecast levels. This allows you to consume
forecasts by sales orders for a specific customer, for example Project and Seiban
References. If you are working in a project-based or Seiban environment, you
can include project/Seiban and task references to your forecast entries if

organizational parameters allow. These references will accompany forecast
copies, loads, merges, and explosion.
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Creating a Forecast Set

Creating a Forecast Set

(N) Material Planning > Forecast > Sets

Copyright © Oracle C ation, 2000. All rights reserved

Forecast Sets
(Help) Oracle Manufacturing Applications > Oracle Forecasting >
Defining a Forecast Manually > Defining a Forecast Set

To Define a Forecast Set
1 Navigate to the Forecast Sets window.
2 Enter a unique Forecast Set name.
3 Select a bucket type to group forecast entries by days, weeks, or accounting
periods.
Select the level that determines how forecasts in the set are defined and
consumed.
* Ship-To: Item, customer, and shipping identifier
» Bill-To: Item, customer, and billing identifier
* Customer: Item and customer

* Item: Without Oracle Order Management or Oracle Receivables, “item” is
the only option you can choose
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Defining a Forecast

Defining a Forecast

ah, yes!!

This should do for
the 2nd quarter.

Copyright © Oracl tion, 2000. All rights res

To Define a Forecast Set (continued)
4 Select consumption options.

* If you turn consumption on, sales orders consume forecast entries in this
set.

* The outlier update is the maximum percentage of a forecast entry that a
single sales order can consume.

* Forward and backward days describe the number of work dates from the
sales order schedule date that forecast consumption searches backward or
forward for a forecast entry to consume. Non-workdays are not counted in
these calculations.

5 Save your work.
You can now define one or more forecasts for this set.
To Disable a Forecast Set

Note: You can view disabled forecasts but not modify them. Enter a disable
date. After this date, you can no longer define a forecast name for the set.
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Creating a Forecast Entry

Creating a Forecast Entry

Let’s see!

I’m going to wan
the 2nd quarter.

Prerequisites
Define at least one forecast set.
To Define a Forecast

1

EENENVS I )

0 3 N DN

Navigate to the Forecast Sets window.

Query a forecast set.

Enter a unique name and description for the forecast.

Choose the Forecast Items button to open the Forecast Items window.
You can choose the Folder menu to customize your display.

Enter an item.

Choose the Detail button to open the Forecast Entries window.

Select a bucket type of days, weeks, or accounting periods.

Enter a date. This is typically the date you expect to ship the item or the
beginning of the week or period that you expect to ship the item.
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Creating a Forecast Entry

Creating a Forecast Entry

No! It’s the 3rd
quarter that | want.

To Define a Forecast (continued)

9 Enter an optional End Date. This creates forecast entries of the same
quantity for each day, week, or period until the end date. A forecast entry
without an end date is valid just for the date and time bucket specified.

10 Enter a current quantity. This also becomes the original quantity. Forecast
consumption reduces the current quantity. Forecast consumption plus the
current quantity equals the original quantity.

11 Enter an optional confidence percentage that the forecasted item will
become actual demand. Oracle Master Scheduling/MRP and Supply Chain
Planning multiplies this percentage by the forecast quantity when you load
it into a master schedule.

12 Optionally, enter the flow line where the product family is to be built.
Note: If left blank, the flow line is derived from the routing.

13 If you are working in a project environment, enter a valid project and task

reference. After entering a valid reference, you can select a price list and
an average discount in the flexfield.

14 Save your work.
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Practice DM-3

Instructions:

Using the following information, perform the setup.

Replace nn with your initials.

Product Family Forecast
1. Create a Forecast Set
2. Add a Forecast Name
3. Add the Forecast item and forecast

4. Add a second Forecast Name for an explosion

1. Create a new Forecast Set, nn-fset, accept the defaults.

Enter a unique name and description.
Select a bucket type to group forecast entries by days

Select the level that determines how forecasts in the set are defined and
consumed. Item: Without Oracle Order Management or Oracle
Receivables, this is the only option you can choose.

Select consumption options.

If you turn consumption on, sales orders you create consume forecast
entries in this set.

The outlier update is the maximum percentage of a forecast entry that a
single sales order can consume.

Forward and backward days describe the number of work dates from the
sales order schedule date that forecast consumption looks backward or
forward for a forecast entry to consume. Nonworkdays are not counted in
these calculations.

Save your work.

2. Add the forecast Name = nn-fc.

Enter a description for the forecast.
Save your work.
Choose the Forecast Items button to open the Forecast Items window
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Practice DM-3 (continued)

Instructions:

Using the following information, perform the setup.
Replace nn with your initials.

Product Family Forecast

1. Create a Forecast Set

2. Add a Forecast Name

3. Add the Forecast item and forecast

4. Add a second Forecast Name for an explosion

3. Add the Product Family as the item. (continued)
*  Choose the Detail button
Add the entries from the table below for your Product Family:
Time Bucket Start Date End Date  Original Qty
Day Today Today + 60 100
Day Today + 61 Today +120 300
Save your work.
Note: Remember your Product Family Allocation is set to:
nn-M1 = 60%, nn-M2 = 40%
4. Add another Forecast Name to the above set, called nn-fexp
Save your work.
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Product Family Consumption

Product Family Consumption

Original Forecast
Item 1 SO
Current Forecast

Original FC =40 T
Salgs Order = 10 Original Forecast = 60

Current FC =30
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Overview of Forecast Consumption

Forecast consumption replaces forecasted demand with actual sales order
demand. Each time you create a sales order line, you create actual demand. If
the actual demand has already been forecasted, the forecast demand must be
subtracted by the sales order quantity to avoid counting the same demand twice.

The Planning Manager is a background concurrent process that performs
automatic forecast consumption as you create sales orders.

Forecast consumption relieves forecast items based on the sales order line
schedule date. When an exact date match is found, consumption decrements the
forecast entry by the sales order quantity. Other factors that may affect the
forecast consumption process are backward and forward consumption days and
forecast bucket type.

Note: When you create a product family forecast and explode it to product
family members, both the product family and the member item forecast are
decremented.
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Forecast Control Attribute

Forecast Control Attribute

Manage products entirely independently

Manage products independently, but reduce data
entry and gain aggregate reporting using forecast
explosions

Manage products aggregately using production
planning and two level scheduling

Attribute Settings
Setting the Forecast Control Attribute on the MPS/MRP region of the Item
Master determines if an item can receive forecasts, how the item receives its
forecast, and with product family members, when the item receives its forecast.
Product Family Settings
» If you set the product family forecast control attribute to none, you disable
its unique function and it operates like a planning bill.

* Set the product family forecast control attribute to consume, or consume
and derive. Both enable the same functionality.
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Forecast Control Attribute (continued)

Forecast Control Attribute (continued)

Manage products entirely independently

Manage products independently, but reduce data
entry and gain aggregate reporting using forecast
explosions

Manage products aggregately using production
planning and two level scheduling

Member Item Settings

Set Member item’s forecast control attribute to Consume if you want to
manage each member item independently instead of part of the family.

Set member item’s forecast control attribute to Consume and Derive if
forecasts come from both product families and its own independent
forecasts. When planning plans for an item with the forecast control
attribute set to consume and derive, the assumption is made that forecast
explosion has been done. Dependent demand is not passed from product
families to items with this attribute setting.

Set member item’s forecast control to None if all of its forecasts come
from product family forecast explosions and you wish the explosion and
consumption to take place during the MPS production plan. When
planning plans for an item with the forecast control attribute set to None,
the assumption is made that forecast explosion has not been done.
Dependent demand is passed from product families to items with this
attribute setting. Demand for the family members is calculated based on
unconsumed forecast for the product families, and sales orders for the
specific family members.
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Product Family Consumption

Product Family Consumption

Product Original Forecast
Family Item 1 SO
Current Forecast
40% | 60%

- Member ltem 1 ~ Member ltem 2
Consume & Derive Consume & Derive

Original FC = 40
Sales Order =10
Current FC =30

Original Forecast = 60
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Member forecast control attribute set to Consume and Derive
Original product family forecast quantity of 100 and the product family
percentages are used to explode an original forecast of 40 for Item 1, and 60 for
Item 2.

Note: This pre-explosion happens during forecast and explosion / or MDS
load

The sales order for 10 of Item 1 consumes the forecast at both the item and the
family level.
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Product Family Consumption (continued)

Product Family Consumption (continued)

- Product Original Forecast =100
Current Forecast = 90

40% 60%

. Member Item 1 ~ Member ltem 2
None None

Original FC =36 Original Forecast = 54
Sales Order =10

Gross Req =46
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Member forecast control attribute set to None

Product family forecasts are not Pre-Exploded to Member items. Instead, the
current product family forecast (original product family forecast quantity — sales
orders for member items) is used to explode quantities to the members at the
time of planning.

In this case, the current product family forecast requirement is 90. This is
exploded to determine the forecast percentages for Item 1 of 36% and Item 2 of
54%

The forecast is calculated, then added to Gross Requirements (though this is not
visible in FC forms).

This method preserves the probability that the next sales order received will still
have a 60/40 chance between the two models, M1 and M2.

Test Your Understanding

Using the previous example of PF forecast of 1000, create a 75/25 split and
book sales orders for M1 of 125, and for M2 of 250.

What is the Current Forecast Quantity for the product family?
What will be the forecast for M2 once the MPS has completed?
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Practice DM-4

Instructions:

Forecast Explosion

1. Explode the Product Family Forecast into Member
Item Forecasts.

. What resulting percent of demand will nn-M2 get
after the explosion into nn-fexp for the first week?

1. Select the Copy/Merge button from the Forecast form.
Enter the following parameters:

Name Enter
Destination nn-fexp
Source Type Specific Forecast
Org M1
Forecast nn-fc
Overwrite All
* All Entries: Deletes everything on the forecast before merging new
information.

* No: Deletes nothing and adds new entries to existing entries during the
merge. Schedule entries are not combined. You can get multiple forecast
entries for the same item on the same day.

* Same Source Only: Deletes the entries that have the same source as those
you merge. You can replace entries on the forecast that were previously
loaded from the same source without affecting other entries on the

forecast.
Dates Today, Today + 120
Explode Yes
Qty Type Original
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Practice DM-4 (continued)

Instructions:

Forecast Explosion

1. Explode the Product Family Forecast into Member
Item Forecasts.

. What resulting percent of demand will nn-M2 get
after the explosion into nn-fexp for the first week?

*  Current: The current forecast quantity is the original forecast quantity
minus any consumption quantities. When you choose this option, you
cannot choose to consume the forecast since the forecast quantities
already reflect sales order demand that has been placed.

* Original: This is the quantity of the forecast without any consumption.
When you choose this option, you should choose to consume the forecast
if you intend to generate a master schedule using forecasts and sales
orders. Consuming the original forecast ensures that demand is not
overstated by balancing the forecast and sales order demand.

Consume No
» accept other defaults, then submit the request.
* Make a note of the concurrent request number.

2. What resulting percent of demand will nn-M2 get after the
explosion into nn-fexp for the first week?
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Practice DM-5

Instructions:

Forecast Explosion

1. What resulting percent of demand did nn-M2

get after the explosion into nn-fexp for the
first week?

2. Why is it zero?

Copyright © Oracl tion, 2000. All rights res

The forecast control attribute for nn-M2 is set to “none.”

When Oracle Planning plans for an item with the forecast control attribute set
to None, the assumption is made that forecast explosion has not been done.
Dependent demand is be passed from models or product families to items with
this attribute setting.

Remember, this was just a forecast explosion, not a planning run.
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Practice DM-6

Instructions:

Forecast Explosion

1. Changes the forecast control attribute on nn-M2 to

Consume and Drive.

. Re-explode the Product Family Forecast into
Member Item Forecasts.

Copyright © Oracle C gtion, 2000. Al rights reserved
1. Change the forecast control attribute
(N) Flow Manufacturing > Products and Parts > Master Items
Product 2: nn-M2 Forecast Control = Consume and Derive
2. Repeat the explosion practice step DM-4. Step 1.
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Available to Promise

Available to Promise

Original Forecast = 100
ltem 1 SO = 10

Current Forecast = 90

Original FC Original Forecast = 54
Sales Order Planned Order =54
Gross Reqs

Planned Order

Copyright © Orac

Member Item Available to Promise

ATP (member item) = MPS (member item) — SO (member item) + WIP jobs
(member item) + PO (member item) + onhand quantities (member item)

e If FC control set to Consume & Derive, ATP for M1 = 30, M2 = 60
» IfFC control set to None, ATP for M1 = 36, M2 = 54
Product Family Available to Promise
ATP (member item) = MPS (product family) — SO (sum of all members)
ATP for both M1 and M2 = 90

Note: By setting a Profile Option, you can perform ATP checks at the product
family level. In this case we know that we can easily flex our flow line to
produce any of the mix of models assigned to the product family. Therefore, if
ATP were performed for either M1 or M2, we could promise another 90.
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Demand Time Fence

Demand Time Fence

MPS
Schedule
for the
Envoy
Laptop

K =30 CcPO

Time
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Using the Demand Time Fence in an MPS

Building to actual customer order demand is a fundamental principle of Flow
Manufacturing. Using the Demand Time fence feature of Oracle Planning, you
can eliminate forecasts from the near planning horizon.

Set the Demand Time fence by item by organization. The length should be set
between the total product cycle time and the lead time quoted to the customer.
Define Demand Time Fence
(N) Flow Manufacturing > Products and Parts > Organization Item
* 1 Select MRP/MPS alternate region.
* 2 Select “User Defined” from the Demand Time Fence drop down
window.
* 3 Enter the number of days between items TPCT and quoted lead time.
— Note: The line should be balanced before determining TPCT Since
the line is usually balanced at peak velocities, you may wish to
round up to the day.
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Master Demand Schedules (MDS)

Master Demand Schedules (MDS)

Planned
Orders

Master Demand Schedule

In a flow environment, a long term forecast is used to design the line, design
kanban sizes, and do capacity planning (via the Mixed Model Map). Then, the
execution system (line scheduling, MMM, work order-less completions, and
kanbans) runs the shop based on actual customer orders. MDS/MPS and MRP are
not required to run the daily activities of the shop floor. However, an MPS or
MRP plan should be used to get long term visibility of component requirements
for kanban items.

Other reasons you may use MDS or MPS:

* You operate in a mixed-mode environment, and you want the MPS to release
production for non-Kanban items, or create planned orders for discrete
production lines operating in the same organization.

* You want to schedule planned orders to compensate for seasonal industries,
spares or internal requisitions.

* You are using Advanced Planning and Scheduling (APS) to optimize your
flow schedules.
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Demand Source for Line Design

Demand Source for Line Design

3rd quarter
forecast

(N) Flow Manufacturing > Product Sync > Mixed Model Map

Line Design/Mixed Model Map

(Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >
Mixed Model Map > Entering Mixed Model Map Parameters

The mixed model map is a tool that displays the processes and products for a
given line as well as the associated weighted times to complete the process. The
mixed model map also displays the labor, machines and In-Process-Kanbans
(IPK) resources needed to support forecast demand. This information is used to
decide how to regroup events into line operations to balance the line.

Demand Type:
Forecast, MDS, MPS or Actual Production. Typically, you use a forecast to
design your line, although you could use an MDS or MPS. Actual Production
uses the current flow schedule in the date ranges you specify below. Use actual
production when you are operating your line and want to compare actual
production mix against your line design.
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Demand Source for Kanban Planning

Demand Source for Kanban Planning

(N) Flow Manufacturing > Kanbans > Kanban Planning > Names

Copyright © Oracle Corporation, 2000. All rights res

Kanban Plans

In Oracle Flow Manufacturing, you are able to create any number of baseline
and simulation kanban plans in which you can calculate and store kanban
quantities for each item/ kanban location. You are able to calculate optimal
kanban quantities based on the demand schedule of your choice. When you
create a new simulation plan, you are able to compare the newly calculated
kanban quantities to those in the current production system (or any other plan)
and make adjustments to the production system at your option.

Create Kanban Plan Name
(Help) Oracle Manufacturing Applications > Oracle Inventory >
Inventory Planning and Replenishment > Overview of Kanban Replenishment

All plans are tied to a specific demand forecast, MDS, MPS, or actual
production.
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The Supply Chain for Laptops

The Supply Chain for Laptops

A - Singapore

A - Boston

A Singapore

down the supply A - Chicago

chain to Kanban

locations ——

ion, 2000. All right:

Planning Method Versus Release Method

A Kanban part can be planned by both the MPS/MRP plans, and the Kanban
planner. Each serve a different purpose.

Set the Planning Method to MPS or MRP, and run the material plans as usual.
In an Supply Chain plan we can plan all inventory organizations in one plan,
driving demand for product down the supply chain to our flow assembly and
Kanban items.

Set the Release Time fence to Kanban - Do Not Release to identify an item as
Kanban-controlled. This prevents any planned orders from being released from
the Planner Workbench, but still allow the planning. Replenishment order is
available through Kanban signals only.

Planning for Kanban Items
* MPS/MRP planning: By day, by inventory organization
» Kanban Planner: By day (or fraction there of), by organization, by
subinventory, by locator
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Oracle Supply Chain Planning Flow

Oracle Supply Chain Planning Flow

Cust — O
Demand Forecast
SO Consume Load

Sourcing
Rules =3 Assign-

Su | ment »
i Bills of = Set

Dist 1 /
No, Use Kanban

Make At Transfer From Release Instead

Execute the Plan i
Flow Internal SUEEE

Schedule Req

DRP

Req

¥

Supplier
Schedule

MPS/MRP Planning of Kanban Items

Use the MPS or MRP plan for Kanban items to be able to see the long term
plan. Communicate this plan to your trading partners, including Marketing and
Suppliers. Executing the plan is restricted to Kanban signals; you may not
execute the plan using the Planner Workbench. Instead, material is pulled on the
line as needed.

* Use the MPS to:

— Release production for non-Kanban items

— Manage long-range capacities with Rough Cut Capacity Planning
* Use the MRP to:

— Determine component requirements months or years in the future

— Build supplier partnerships by communicating requirements via a
supplier schedule built from planned orders, or WEB inquiry
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Advance Notice

Advance Notice

Orders are increasing,
I’m going to need
more material
next week!

tion, 2000. All right

Managing Demand Within Tolerance Fences

You can specify how much a supplier or a manufacturing line can accommodate
demand over its usual capacity when given advance notice. For example, you
can specify that a 10 percent increase is allowed when notice is given at least 2
days in advance notice.
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Negotiated Tolerance Fences

Negotiated Tolerance Fences

Qty Kanbans sized
Line design

demand Supported by:

» Marketing
management
* Suppliers

10% 30%
* Kanban

Advancing the line rate line design

f

Tomorrow
2, 3, 4 days out

5 days or more out
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Definition and Business Process

Tolerance fences represent a percent increase to the daily production rate that is
allowed for a given amount of time in the future. You can specify tolerance
fences for item and supplier combinations that represent the amount of flex
negotiated with your suppliers based on an advance notice given to them. You
can also apply tolerance fences to your manufacturing lines. These values are
used in determining when demand on your supplier or manufacturing line can
be increased above negotiated limits.
Benefits:

* Allows your supply chain to react to changes in customer demand

» Contributes to fewer stock outs

* Produces lower safety stock levels

* Customer satisfaction due to orders being shipped on time
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Supplier Tolerance Fence Setup

Supplier Tolerance Fence Setup

In 90 days, please increase delivery by 10%

(N) Purchasing > Supply Base > Approved Supplier List
(B) Attributes (T) Planning Constraints

Supplier-ltem Attributes

(Help) Oracle Purchasing > Supply Base Management > Defining the
Supplier/Item Attributes

Setup

In the Supplier-Item Attributes window under the Planning Constraints tab, you
can enter the following in the Tolerance Fences region:

*  Number of days in advance
* A tolerance percentage

Note: These are not required fields. Once you have entered them, you can
update them at any time.

Considerations

Tolerance fences are designed to work with APS and Supply Chain Planning.
They inform the supplier of an anticipated increase in demand at some point in
the future. The supplier in turn uses this information for planning purposes. The
actual commitment to purchase these increased quantities is not made until a
purchase order is issued or a release against a blanket purchase order is released.
During implementation, when you decide to use these tolerance fences, you can
establish these constraints based on discussions and negotiations with your
suppliers.
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Manufacturing Line Tolerance Fence Setup

Manufacturing Line
Tolerance Fence Setup

Because of the increase in widget demand, we’ll have to start
making 20% more in 60 days.

(N) Flow Manufacturing > Lines > Lines
(B) Tolerance Fences

Tolerance Fences
(Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >
Setup
In the Tolerance Fences window, you can enter the following data:
*  Number of days in advance
» Tolerance percentage

Note: These are not required fields. Once you have entered them, you can
update them at any time.

Considerations

Tolerance fences are designed to work with APS and Supply Chain Planning.
During implementation, when you decide to use these tolerance fences, you can
establish these values based on discussions and negotiations with your
manufacturing personnel. The values are also applied during line scheduling, if
sufficient demand exists at the future date, the line rate is increased accordingly.
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Summary

Summary

In this lesson, you learned how:

Demand Management plays a role in Flow
Manufacturing.

To create and maintain product family forecasts .
Product Families and member items are
consumed.

To create demand sources for line design and
kanban planning.

MDS/MPS function in Flow Manufacturing.

The use of tolerance fences can smooth increases
to your customer demand.
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